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Abstract of Thesis
Annual precipitation pattern over Long Island based on Radar Data
By
Lisha Zhou
Master of Science
In
Geosciences
Stony Brook University
2008
Precipitation is the only source of fresh water on Long Island. Thus, accurate
measurements of precipitation are very important for hydrological modeling of Long
Island aquifers. Traditionally, rain gauges have been used to measure rainfall
accumulation but rain gauge networks are too expensive to develop for measuring
precipitation at the resolution necessary for most hydrology applications. In order to
determine the spatial variability of rainfall over Long Island, we have applied Next
Generation Radar (NEXRAD) precipitation data to Long Island, which provide rainfall
data with a relatively high spatial (4*4 km2) and temporal resolution (15 minutes) using
the data processing methods originally developed by Xie 2003. Our 2004-2007 annual
precipitation patterns show that the difference between the maximum and minimum
annual rainfall is about 25 inches on Long Island each year. The variability in rainfall on
Long Island is dependent on the sources of rain. During the warm season (April through
September) precipitation is mainly from frontal activity and hurricanes resulting in a
greater rainfall on the western end of the island. During the cold season precipitation is
mainly influenced by Nor’easters and has a more widespread distribution. As a result, for
iii

the annual accumulation, more precipitation falls on the western and northwestern part of
Long Island, and less fall along the south shore and through the center of the island.
Comparison of annual radar rainfall with annual rain gauge rainfall generally shows
agreement with average difference of 2.3 inches, which makes us confident that we can
apply the radar precipitation data to rainfall related applications for Long Island.
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Chapter I: Introduction.
Long Island depends solely on groundwater for its water supply, and precipitation
is the only source of groundwater on Long Island (Busciolano 2002). Hence, the study of
precipitation is logically the first step in developing a better quantitative understanding of
the hydrologic cycle of Long Island (Miller and Frederick, 1969). Traditionally, rain
gauges have been used to measure rainfall accumulation at a point and generally provide
good quality data for a small area. Long Island has around 15 rain gauge stations,
operated by National Weather Service, that provide long term precipitation records for
past decades. But the existing rain gauge network is not capable of detecting precipitation
at the resolution necessary for most hydrometeorology applications, and a higher density
rain gauge networks would be costly in terms of equipment and labor to implement and
maintain (Wang et al. 2008). Problems with rain gauges have been documented in several
studies (e.g., Legates and DeLiberty 1993, Jayakrishnan et al. 2004). Wind speed,
temperature, shelter-height, gauge height, deleterious effects of the wind and wetting
losses on the interior walls of the gauge may be the sources of significant inaccuracy,
which contribute 4-6% error during summer and more than 35% during winter (Legates
and DeLiberty 1993).
Radar measurements of precipitation provide rainfall data with much higher spatial
and temporal resolution than rain gauges (Wang et al. 2008). The National Weather
Service installed the Next Generation Weather Radar System (NEXRAD) across the
country to provide better meteorology service to the whole country in the early 1990s.
The NEXRAD consists of 159 high resolution Doppler weather radar stations throughout
US and selected oversea locations (Figure1.1). National Weather Service divided the
radar network into 13 different River Forecast Centers and each River Forecast Center
contains 9-20 radar stations (Figure 1.2). Long Island belongs to Northeast River Forecast
Center. The radar system generates data every 15 minutes, if it is in the clear air mode,
1

every 6 minutes, if there is precipitation, with a spatial resolution of 4*4 km2. The
NEXRAD has greatly improved detection of severe wind, rainfall, hail, and tornadoes
(Fulton et al. 2002).
According to sequentially increasing preprocessing, calibration and quality control,
NEXRAD precipitation products are classified into four stages (I-IV). The most useful
NEXRAD product for hydrometeorological application is NEXRAD Stage III data since
it involves the correction of radar rainfall rates with multiple surface rain gauges by
trained personnel at individual River Forecast Center (Fulton et al. 1998, Xie et al. 2003).
The NEXRAD Stage III precipitation products, which have a spatial resolution of 4*4
km2, are hourly accumulations with HRAP (Hydrologic Rainfall Analysis Project)
projection after calibrated with gauge observation and combined individual radar
observations to cover an entire River Forecast Center (Wang et al. 2008).

Figure 1. 1 Weather Radar Network (NEXRAD) Covering US
2

Figure 1. 2 Thirteen River Forecast Centers of US

The Stage III data were improved to Multi-sensor Precipitation Estimator (MPE)
data after 2000 by the National Weather Service Office of Hydrology. MPE is a radar
precipitation product that merges radar data, rain gauge measurements and Geostationary
Operational Environmental Satellite data together. The Northeast River Forecast Center
switched from Stage III data to MPE data in Aug 2002. MPE data has more quality
control over Stage III data and generates more accurate precipitation estimations. The
improved performances of MPE data over Stage III data are documented in several
studies (e.g. Wang et al. 2008, Over et al. 2007).

Stage III and MPE radar rainfall data

are available from1996 to the present.
Although Stage III and MPE data potentially provide precipitation data with higher
spatial and temporal resolution, they are difficult to use in conjunction with other
geospatial products due to its HRAP projection, the large size of multi-tarred data and
compressed binary data format (Xie et al. 2005, Reed and Maidment 1999). Xie et al.
(2003) at the University of Texas at San Antonio developed an automated radar data
processing system to automatically process the NEXRAD Stage III and MPE data. This
3

data processing method has been implemented using a commercial GIS program and a
number of Perl scripts, AML (Arc Macro Language) scripts and C/C++ programs (Xie et
al. 2005). In order to apply the NEXRAD automatic data processing system to Long
Island, which belongs to different River Forecast center, changes were made to all of the
Perl and AML scripts by the author of this article. The output precipitation data are in a
GIS grid format which can be directly imported into GIS software, image processing
systems, terrain and watershed analysis programs and hydrological models (Xie et al.
2005). They provide better precipitation results for hydrologic modeling, climate
modeling and drought monitoring.
The purpose of this study is to:
(1) Apply NEXRAD precipitation data (MPE) to get the annual, seasonal and
monthly precipitation pattern over Long Island.
(2) Introduce to the Long Island hydrologic community the data processing
methods of NEXRAD precipitation products (Stage III and MPE) for Northeast Forecast
Center.
(3) Assess the variability of precipitation over Long Island and its relation to the
variability in recharge of groundwater across Long Island.
(4) Examine the contribution of different precipitation sources (frontal activity,
hurricanes, Nor’easters and air mass thunderstorm) to annual, seasonal and monthly
precipitation pattern over Long Island.
(5) Discuss the potential use of radar precipitation results for the hydrology of Long
Island in future.
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Chapter II: Data Processing.
2.1 Batch Processing NEXRAD MPE data
In this section, methods to automatically batch-process NEXRAD MPE data are
described. Computer scripts for automatically processing data were originally developed
by Hongjie Xie and his research group at the University of Texas at San Antonio.
Changes to the scripts were made in order to apply them to radar data for Long Island,
which is in a different River Forecast Center.
To extract hourly MPE products (in XMRG format), we first untar the monthly file
to get the daily files, untar the daily files to get the compressed hourly files, and then
uncompress the hourly files. A Perl script operated on Linux system was developed for
this purpose (attachment 1). The hourly XMRG files were then read and transferred to
ASCII files, using a C script (attachment 2) that operates on a Linux system. The ASCII
files were then transferred to ArcGIS grid files. From these grid files, we could define
their projection (polar stereographic) and then re-project the data to any selected
projection system. An AML script (attachment 3) was developed for this purpose. Finally,
I summarized the monthly, seasonal and annual results in ArcInfo from an AML scripts
(attachment 4). Details of automatically batch processing NEXRAD MPE data were
described in the following where 2004 data are used as an example.
2.1.1 Preparation
In preparation for data processing, the following steps were taken:
• Download

2004

MPE

radar

rainfall

data

month

by

month

from

http://dipper.nws.noaa.gov/hdsb/data/nexrad/wgrfc_mpe.php (binary XMRG format).
Save as the original data.
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• Download the original scripts for processing the data from the following link:
http://www.utsa.edu/LRSG/Teaching/EES6973-06/mpe.zip, three files: mpe2ascLinux.c,
mpe2ascLinux and Munc-E.pl are in the uncompressed folder. The first one is the C
source code for converting the MPE XMRG format to ASCII, the second one is the
executable file, and the third one is the Perl script which does the untaring, unzipping,
and repeating work.
• Login to the Linux system. Create a folder, copy the first two files to this folder,
and create a Data subdirectory under it, copy the Munch-e.pl and downloaded MPE data
to the Data subdirectory. The data can be processed either month by month, or year by
year. I did it month by month in order to show the variance in the monthly rainfall.
Besides, it is also easier to get the summed results for warm and cold seasons from these
monthly results.
2.1.2 Convert the compressed monthly files into hourly ASCII files using the Perl
and C program running on the Linux platform.
Create a “New terminal window” in SSH (Secure Shell) (Figure2.1). Type ‘ls”
–display directory and files; and ‘cd’ – change directory to Data folder where you store
your downloaded MPE data and your Perl script (Attachment 2). Then input
“./munch-E.pl” and click enter. Before you run the ./munch-E.pl, we need to change the
permission to both mpe2ascLinux and Munch-e.pl, by typing “chmod 744” the filename.
This will automatically untar and uncompress the monthly file into an hourly ASCII file.

6

Figure 2. 1 SSH window to upload and process the data in Linux system

• Create two new folders, GridData and ASCData, on the local computer
• Transfer the converted hourly XMRG radar rainfall ASCII files from the Server
(from the Window of Figure2.1) to your folder ASCData in the local computer.
2.1.3 Convert the ASCII file into GIS Grid file using the ArcInfo workstation on the
Window platform
• Open Notepad, copy code asc2grid (Attachment 3) to the Notepad. Change
&Workspace G:\RadarData\ASCData\2004ASC\012004ASCII to your own ASCData
folder, then change the G:\RadarData\GridData\2004Grid\012004Grid to your own
GridData directory. Then, save the code as asc2grid.aml into C:/workspace.
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• Download

the

compressed

“z0101200018.zip”

http://www.utsa.edu/LRSG/Teaching/EES6973-06/z0101200018.zip

file
and

save

from
it

in

C:/workspace. Then unzip it.
• Open ArcInfo from: Programs->ArcGIS->ArcInfo Workstation->Arc
• Run code: &r asc2grid
2.1.4 Summarize the annual and seasonal results in ArcInfo.
To conduct radar rainfall analysis within a selected time frame, an AML script
(Attachment 4) was developed to process spatial–temporal grid files. This AML script
was capable of accumulating radar rainfall data for a particular user-defined period, such
as a particular storm event, daily, monthly, seasonal, and annual. The script first counts
the number of grid files in the directory where you located your target files, and then the
algorithm accumulates the radar rainfall rates and stores the cumulative fields in a new
GIS grid file for subsequent analysis or query.
Monthly Results:
• Create twelve folders named month by month (for example: 012004, 022004) in
local computer.
• Copy all of the converted ASCII files month by month into these folders.
• Open Notepad, copy “gridsum” code (Attachment 4) to the Notepad,

change

the working directory G:\RadarData\2004 Monthly\012004 to your own working folder,
then save the code as sumgrid.aml into C:/workspace
• Open ArcInfo from: Programs->ArcGIS->ArcInfo Workstation->Arc
• Run code: &r gridsum
After running gridsum.aml for all the grid files in a month (744files/month), a new
grid file named “gridsum” will appear in each folder automatically. Copy this “gridsum”
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file to a new folder and rename it as the month and year it is summed for. Organize this
monthly results folder and prepare it for processing seasonal and annual results.
Seasonal Results:
• for warm (April-September) and cold season (October-March): copy the
summed monthly results (Apr, May, Jun, Jul, Aug and Sep) to a new folder named 2004
Warm Season; copy the summed monthly results (Oct, Nov, Dec, Jan, Feb and Mar).
• Open Notepad, copy “gridsum” code (Attachment 4) to the Notepad,

change

the working directory G:\RadarData\2004Season\2004Warmseason to your own working
folder, then save the code as seasumgrid.aml into C:/workspace
• Open ArcInfo from: Programs->ArcGIS->ArcInfo Workstation->Arc
• Run code: &r seagridsum
The summed seasonal results will automatically appear after running this aml
script.
Annual Results:
It could be done in two ways:
• Use the gridsum scripts to sum the 12 monthly results in one year, or
• Use the gridsum scripts to sum the 2 seasonal files (warm and cold season).
• Processors are the same as getting the seasonal results, just creating new
working folder and indicating the new working directory in gridsum script.

.

2.1.5 Sum the results only for the region of interest.
For a regional application of the NEXRAD MPE precipitation data, a new aml
script (Attachment 5) was developed to clip the rainfall data for a sub-region or cell of
interest, and create standard formats that facilitate the comparison between radar and rain
9

gauge measurement. The “gridsum-clip” script was developed for either clipping a box of
interest from each original radar grid file and then only summed the grids within the box,
or creating coverage file and only summed the results within the coverage file in
C:\workspace. This gridsum-clip script saved us much time in data processing.
The script performs a variety of functions, including (Xie, et al. 2003) (1) Create an
output text file to store rainfall information retrieved from the grid files (e.g., event time,
cell position, and rainfall rate). (2) Count the number of grid files within the monthly
subdirectory.

(3) Utilize the ArcInfo Grid function GRIDCLIP to clip each grid to a

user-defined box (x-min, y-min, x-max, and y-max) or polygon coverage and create
subgrid files. (4) Load the retrieved rainfall information into the defined output text file.
Box of interest:
• Open Notepad, copy “gridsum-clip” code (Attachment 5) to the Notepad.
Change /*BOX 306333.855790 3784270.867612 362333.855790 3812270.867612 to
your own working area. The coordinates should be in UTM.
• Change the working directory G:\RadarData\2004Season\2004Warmseason to
your own working folder, then save the code as sumgrid-clip.aml into C:/workspace
• Open ArcInfo from: Programs->ArcGIS->ArcInfo Workstation->Arc
• Run code: &r gridsum
Coverage of Interest:
• Create a coverage file in ArcCatalog, and then create your region of interest in
that coverage file.
• Copy your coverage file to C:\ Workspace.
• Open Notepad, copy “gridsum-clip” code (Attachment 5) to the Notepad.
Change waterbasin_cov to your newly created coverage file that stored in C:\
workspace. .
10

• Change the working directory G:\RadarData\2004Season\2004Warmseason to
your own working folder, then save the code as gridsum-clip.aml into C:/workspace
• Open ArcInfo from: Programs->ArcGIS->ArcInfo Workstation->Arc
• Run code: &r gridsum-clip

2.2 Processing NEXRAD Results in ArcGIS
The radar precipitation results can be re-projected, clip, and output with map
components in ArcGIS.
2.2.1 Re-project the regional map.
• Launch ArcMap -> Open Arc Toolbox -> Data Management Tools -> Projections
and Transformations -> Raster -> Project Raster.
• Re-project the regional precipitation maps to WGS_1984_UTM_Zone_18N
• Save the re-projected maps to a new folder named Projected.
2.2.2 Clip the region of interest
• Launch ArcMap -> Open Arc Toolbox -> Data Management Tools -> Raster ->
Clip.
• Locate your target files from “Projected” folder, and clip your region of interest
by indicating the coordinates of four corners.
• Save clipped image to a new folder named Clipped.
2.2.3 Output precipitation maps.
• Launch ArcMap, add precipitation maps from “Clipped” folder.
• Select color ramp for your map (invert Algorithmic color ramp).
11

• Add the Long Island Coast shapefile to the map and make the fill color
transparent.
• From the lay out view, add legend, title and north arrow to the map.
• Output the precipitation map in JPEG or Tiff format.

12

Chapter III: Results.
3.1 2004 Radar Precipitation Results for Long Island.
3.1.1

2004 Annual Precipitation Pattern
The annual precipitation across Long Island for 2004 is shown in Figure 3.1.

The

precipitation for each radar image grid (4x4 km2) is represented by different colors of the
rainbow: red having the most precipitation and blue the least.

Figure 3. 1 2004 Annual Precipitation Map of Long Island

Table 3. 1 Basic Statistics for 2004 Annual Precipitation Map
2004 Annual Precipitation

Unit: mm

Unit: inches

Max

1436. 300

56.547

Min

808. 01

31.81

Annual Mean

1141.782

44.952

Areas of higher elevation to the north and east of New York City received more
rainfall than Long Island. On Long Island, precipitation was highest in the western and
eastern parts. Average precipitation for western Long Island was 52 inch/yr (1300 mm/yr)
and for eastern Long Island 47 inch/yr (1200 mm/yr). Lowest values are along the south
13

shore and through the center of the island, where the average rainfall is around 37.5
inch/yr (950 mm/yr).
These results were compared with the annual precipitation pattern for 1960 by the
U.S. Weather Bureau in 1969 (Figure 3.2). The 1960 annual precipitation pattern map
was overlaid onto a DEM of Long Island to show the relation between precipitation and
elevation.

Figure 3. 2 Areal distribution of total precipitation over LI DEM for water year 1960
(Miller and Frederick, 1969)

The two maps show similar patterns. In 1960, New York City areas also had higher
rain fall (60 inch/yr in the center). Western and northeastern Long Island and areas with
higher elevations on Long Island had higher rainfall (58 inch/yr in the center). The South
Shore and the middle of Long Island had lower rainfall (45inch/yr).
3.1.2

2004 Warm and Cold Season Precipitation Pattern
The warm season was from April to September, and the cold season was from

October to next March.

14

Figure 3. 3 2004 Warm Season Precipitation Map of Long Island

For the 2004 warm season (Figure 3.3), much more precipitation accumulated in
the west (36 inches) and less in the center and along the South Shore (18 inches). During
the warm season, most of precipitation is associated with convective storms that come
from the interior of the continent (Colle, 2006).

Figure 3. 4 2004 Cold Season Precipitation Map of Long Island

15

For the 2004 cold season (Figure 3.4), the difference between the maximum and
minimum precipitation is less than 10 inches. Much of the precipitation during cold
season is associated with northeasters (or the occasional tropical hurricane in October,
Miller and Frederick, 1969) as a result there tends to be more precipitation in the east.
3.1.3

2004 Gauge-Radar Comparison
In order to evaluate the accuracy of the NEXRAD precipitation results, the radar

results were compared to 11 rain-gauge records on Long Island. The rain gauge data
could be found in NCDC database http://cdo.ncdc.noaa.gov/dly/DLY. There were more
than 20 rain gauges for Long Island in their database, but only 10 of them could be used
for the 2004 annual precipitation comparison. This was because several weeks or months
of data for some stations were missing. The Brookhaven National Laboratory (BNL)
annual precipitation data were found at http://www.bnl.gov/weather/4cast/precip.html.
Radar rainfall data for each station were extracted from the radar cell (4*4 km2) where
the rain gauge stations were located. The rain gauge stations are located on a DEM of
Long Island in Figure 3.5.

Figure 3. 5 Distribution of 11 rain gauge stations over DEM

A comparison of the 2004 annual Rain-gauge and radar precipitation data are
shown in Table 3.2 and Figure 3.6.
16

Table 3. 2 2004 annual Rain Gauge and Radar data for 11 stations on Long Island
Gauges Data (cm)

Radar Data (cm)

Islip Airport

99.6

94.7

Bridgehampton

135.9

117.3

Mineola

121.6

117.1

Central Park

131.9

131.4

JFK Airport

129.4

123.7

LaGuardia

128.7

129.9

Riverhead

112.6

104.5

Centerport

144.1

118.1

Sea Cliff

126.5

128.1

Wantagh Cedar Creek

110.1

113.9

BNL

91.1

90.9
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Figure 3. 6 2004 Rain gauge – Radar Comparison

Most of the radar precipitation data agree well the rain gauge data. For seven
rain-gauge stations the difference between the rain gauge and radar data is less than 5 cm
(or 2 inches). However for two stations Bridgehampton and Centerport, the difference is
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19cm and 26cm respectively. These two rain-gauge stations have areas of higher
elevations between them and the source of the radar at Brookhaven National Laboratory.
The other stations did not have such a potential blockage. The special geographical
location of these two stations may contribute to the larger difference.

Figure 3. 7 Centerport rain gauge station on DEM

Figure 3. 8 Bridgehampton rain gauge station on DEM

The Centerport station is located in the northwest of the Harbor Hill Moraine, the
radar is from the east, red arrow (Figure 3.7). Some of the radar beam might be blocked
18

by the moraine in front of the Centerport station. For Bridgehampton (Figure 3.8), the
situation is similar. The radar beam coming from the west may be blocked by the
Ronkonkoma Moraine.
3.1.4

Problems with radar data – Radar Beam Blockage
There is a zone of low precipitation (marked by a pink arrow in Figure 3.9) along a

line to the northwest of the source of the radar at Brookhaven National Laboratory. The
zone is on each radar precipitation map whether monthly, seasonal or annual. Dr. Xie at
the University of Texas at San Antonio indicated that this might result from radar beam
blockage. This seems to be the case, because there is a stack northwest of the radar
station at Brookhaven National Laboratory. It was supposed to have been taken down a
few years ago, but was not. Since this high stack is close to the radar station, part of the
radar beam is blocked by it which generates zone of low precipitation on each of radar
precipitation map.

Figure 3. 9 Zone of low precipitation on the 2004 Annual Precipitation Map

19

Figure 3. 10 2004 Annual Precipitation for Northeast Region with 9 Radar Stations
(LI on lower right corner and colored blue)

2004 NERFC (Northeast River Forecast Center) annual precipitation map (Figure
3.10) informed me that radar beam blockage was a common problem for nearly every
radar station.

More than one radar beam blockage could be observed from other radar

stations in the Northeast region. Long Island (lower right corner) only has one radar beam
blockage on the radar precipitation maps.
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3.2 2007 Radar Precipitation Results for Long Island.
3.2.1

2007 Annual Precipitation Pattern

Figure 3. 11 2007Annual Precipitation Map of Long Island

Table 3. 3 Basic Statistics for 2007 Annual Precipitation Map
2007 Annual Precipitation

Unit: mm

Unit: inches

Max

1520.3

60

Min

778.2

31

Annual Mean

1044.4

41

In 2007 (Figure 3.11) again there was more rainfall on western Long Island. This
pattern is similar to that of 2004.

Annual accumulated rainfall in 2007 was 55 inches/yr

in the west but only 31 inches/yr in the east.

Along the South Shore and through the

center of Long Island the average rainfall is around 33 inch/yr (850 mm/yr).
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3.2.2

2007 Warm and Cold Season Precipitation Pattern

Figure 3. 12 2007 Warm Season Precipitation Map of Long Island

The warm season precipitation map (Figure 3.12) again shows more precipitation
in western Long Island (average 33 inches) compared to eastern Long Island (average 20
inches).
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Figure 3. 13 2007 Cold Season Precipitation Map of Long Island

For the 2007 cold season (Figure 3.13), there is not as much variation in the
precipitation as found for the warm season. The precipitation difference is less than 12
inches. The 2007 cold season pattern is different from that in 2004, with more
precipitation in the west and less in the east of Long Island.
3.2.3

2007 Gauge-Radar Comparison
For 2007, only 5 rain gauge data were available to do the annual Gauge-Radar

comparison (Table 3.4 and Figure 3.14).
Table 3. 4 2007 annual Rain Gauge and Radar Comparison
2007

Rain-gauge (inches)

Radar (inches)

Islip AP

42.9

39.9

Central Park

61.7

59.9

JFK

46.9

46.1

Laguardia

53.4

59.9

BNL

45.3

39.3

2007 LI Gauge-Radar Comparison

Precipitation(inch)

70
60
50
40

Raingauge

30

Radar

20
10
0
Islip AP

Central
Park

JFK

Laguardia

BNL

Stations

Figure 3. 14 2007 Rain-gauge radar comparison
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The comparison result showed that the difference between radar and rain-gauge
was within 6 inches (15 cm) for 2007. For Islip, Central Park and JFK stations,
gauge-radar results agree within one to two inches. For LaGuardia, the radar
overestimated the annual precipitation by six inches.
3.2.4

2007 Monthly Pattern
The precipitation pattern for each month in 2007 is shown in Fig. 3.15..
2007 January:

2007 February:
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2007 March:

2007 April:

2007 May:
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2007 June:

2007 July:

2007 August:
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2007 September:

2007 October:

2007 November:
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2007 December:

Figure 3. 15 2007 Monthly Precipitation pattern maps (Jan-Dec)

As can be seen from the 2007 monthly precipitation pattern maps:
1). The cold season (Jan, Feb, Mar and Nov) has more precipitation on the east end
of Long Island.
2). The warm season (April, May, Jun, Jul and Aug) has more precipitation on the
west end of Long Island and much less in the east.
3). the weak pattern shown on the September precipitation map might due to small
amount of precipitation in September. It was much drier than other months in the warm
season, with 8-77cm range compared to 30-200 cm rainfall range for other months.
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3.3

2005 and 2006 Radar Precipitation Results for Long Island.

3.3.1

2005 and 2006 Annual Precipitation Pattern

Figure 3. 16 2005 Annual Precipitation Map of Long Island

The 2005 annual precipitation map (Figure 3.16) showed a quite different pattern
from the 2004 and 2007 results. The annual Max value for the map was twice as high as
that for 2004 and 2007. There was an extraordinary high value region in the middle of
north Long Island. I was not sure why there was very high rainfall in the center of the
island until the individual monthly maps for 2005 were studied.
2006 Annual Precipitation map (Figure 3.17) also did not show a clear rainfall
pattern. But the annual Max and Min value were close to 2004 and 2007 results. More
precipitation seemed to occur in the west and middle of Long Island. After exploring
monthly maps, we found 2006 data had the same problems as 2005.
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Figure 3. 17 2004 Annual Precipitation Map of Long Island

3.3.2

Problems with 2005 and 2006 data: Bad Data Points.

Figure 3. 18 Bad Data Points on 2007 Annual Precipitation Map
30

In every annual precipitation map (2004-2007) for Northeast region, I found there
were some radar grids that generated much higher values than surrounding areas, shown
in white points in Figure 3.18. Those high value grids are bad data points. There are a
number of reasons that could cause degraded data quality. By its nature, radar
precipitation estimates had numerous error sources. For example, wind farms or tall
buildings in the vicinity of radar could have negative impact on the radar data, and cause
misleading results. Also, the radar itself needed to be regularly calibrated to ensure
appropriate measurements. And finally, there is not a perfect correlation between radar
measured reflectivity and precipitation. However, Robber Shedd in NERFC suggested
that “based on the data performance in 2007 and 2008, I can assume that whatever caused
the errors in 2006 has been resolved”. As a result our 2007 annual precipitation map
looked much better than the 2005 and 2006 results.
3.3.3

Monthly maps of 2005 reveal bad data points.

The 2005 and 2006 monthly precipitation pattern clearly showed where the error
source was. In February 2005 rainfall map, there was a high value region appeared in the
north middle of Long Island, circled in pink ellipse in Figure 3.19. The same high value
region was found in March 2005 rainfall map (Figure 3.20)

31

Figure 3. 19 2005 Feb Precipitation Map of Long Island

Figure 3. 20 2005 Mar Precipitation Map of Long Island

It is nearly impossible to have exactly the same “pattern” for two monthly
precipitations. The problem is inherent in the radar data producing bad data points. As
mentioned before, these degraded data quality could be caused by a number of unknown,
such as truncation errors, untimely calibration of the radar data and
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anomalous

physical phenomenon. But those bad data points are more likely due to some ephemeral
glitch in the data processing. When recognized, they should be removed by interpolation
and smoothing.
3.3.4.

2005&2006 Rain-gauge Radar Comparison.
Although 2005 (Feb, Mar, Apr, May) and 2006 (Jan, Feb) monthly radar

precipitation maps show some bad data points, our 2005 and 2006 annual rain gauge
radar comparison results still show good agreement (Figure 3.21 and 3.22). That may due
to none of the rain gauge stations are in the regions with bad data points (See Figure 3.19
and 3.20, region in pink ellipse).
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Figure 3. 21 2005 Rain-gauge Radar Comparison
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Figure 3. 22 2006 Rain-gauge Radar Comparison

2005 Rain-gauge Radar comparison shows that radar underestimates the
precipitation for all of rain gauge stations except Islip. For 2006, the radar has the trend to
overestimate the precipitation for most of stations. The comparison results inform that
2005 and 2006 annual precipitation maps are still valuable in getting the annual
precipitation value for Long Island.
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Chapter IV: Discussion
In this chapter, I discuss the influence of five different sources of precipitation to
Long Island; the importance of rainfall variability in understanding Long Island
groundwater hydrology; the application of the radar precipitation data; and finally, I give
suggestions to the potential user of the NEXRAD precipitation data.

4.1 Precipitation Variability over Long Island
Several different conditions on Long Island cause large-scale lifting and cooling of
the air that produces precipitation.
(1) Frontal activity: The lower temperature over the Atlantic Ocean during summer
causes higher pressure above the sea compared to interior of the US. Air mass travels
from the ocean to the continent under the pressure difference. Denser and colder air forms
an air wedge that extends onto the continent. The warm and humid air mass associated
with fronts from the west condenses after lifting over the cooler high-pressure mass near
the east shore of US, and produces precipitation over a wide area. These fronts usually
extend from the southwest to the northeast and move eastward or southeastward (Miller
and Frederick, 1969).
(2). Air mass thunderstorms: also known as convective storms, occur during
periods of atmospheric instability, especially during the summer. They develop during
warm and humid days when the sun heats the lower layers of the atmosphere. In late
afternoon or evening the warm air rises, forming large cumulus clouds at high altitudes
which may produce thunderstorms (Miller and Frederick, 1969). The areas of intense
rainfall associated with these thunderstorms are usually small and more isolated
compared to those associated with frontal activity. The rain falls as showers with rapidly
changing intensity, and occasionally includes hail.
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(3). Hurricanes: hurricanes that affect Long Island form over the tropical water of
the Atlantic Ocean, the Caribbean Sea, or the Gulf of Mexico (Miller and Frederick,
1969). Hurricanes, also known as tropical cyclones, usually travel first westward and then
northward. In the northern hemisphere, they rotate counterclockwise. The rainfall
produces flooding rain and strong winds which last from hours to days over east coast
regions. In recent years, there were more than 10 hurricanes over the Atlantic Ocean each
year. Each year, one or two of these may affect Long Island producing high rainfall.
Hurricanes can occur at any time of the year but occur with greatest frequency during the
months of June-through October and thus can contribute significant amount of
precipitation during either the warm season (April-September) or the cool season
(October-March).
(4). Nor’easter: Northeasters (Nor’easter) are low-pressure systems that move
roughly northeastward along the Atlantic Coast. As the storm approaches New England
from the south, its intensity increases and the resulting counterclockwise cyclonic winds
affect the coast and inland areas from a northeasterly direction (Wikipedia 2008).
Nor'easters can occur at any time of the year but are more prevalent during the winter. .
(5). Orographic lifting: Orographic precipitation is caused by rising air motion on
the windward side of mountains. It is well known on oceanic islands. Precipitation can be
enhanced via forced lifting, upstream flow blocking and mountain gravity waves aloft
(Colle and Yuter 2006). Colle and Yuter (2006) found that even the hills (50-100m) on
Long Island produce a 30-40% enhancement of precipitation for a single storm.
4.1.1 Warm Season (April through September)
During the summer months, much of the precipitation is due to the rainfall
associated with the passage of cold fronts. Summer frontal activities can last for more
than one day and can contribute large amounts of precipitation. Frontal activity rainfall
usually contributes a west-east decrease in the precipitation pattern on Long Island. For
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example, the rainfall in the 2007 warm season: April, June, July and August monthly
precipitation was mainly influenced by frontal activity, with much more precipitation on
the west as compared to the east end of Long Island (Figure 3.15).
Another major source of summer precipitation is air mass thunderstorm. Since the
areas of intense rainfall associated with these thunderstorms are usually small and more
isolated than those associated with frontal activity, air mass thunderstorms produce a
more dissipated rainfall pattern and contribute less to the annual precipitation distribution.
For example, 2007 May and September precipitation were mainly influence by air mass
thunderstorms. The maximum rainfall amounts for these two months are 2.48 inches and
3.03 inches respectively, comparing with 8.78 inches average maximum rainfall value for
other months during the 2007 warm season. The monthly precipitation patterns for 2007
May and September are completely different from other months in the warm season, with
dissipated distribution compared with strong west-east decreasing rainfall patterns
(Figure 3.15).
Hurricanes can also cause high rainfall during the warm season. During 2004 -2007,
there were 15, 28, 10 and 14 hurricanes respectively over the Atlantic Ocean. Usually, the
eye of hurricanes misses Long Island, but the rainfall associated with hurricanes occur far
from the eye of the storm and bring precipitation to Long Island (Vermette 2007). In 2004,
hurricanes Bonnie (August 3-13), Charley (August 9-14), Gaston (August 27-September
1) and Hermine (August 27-31) affected Long Island and contributed significant
precipitation during August. Those hurricanes made the precipitation pattern in August
totally different from other warm season months, with highest value in the east and
southwest of Long Island. For 2005, hurricane Cindy (July 3-7) and Ophelia (September
6-17) affected Long Island. The Sep 2005 precipitation pattern was different from other
warm season months with much more precipitation accumulated in the northeast of Long
Island. Compared with other warm season rainfall patterns, the Jul 2005 rainfall pattern
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was not changed too much by hurricane Cindy because of its short duration and strength.
For 2006, only hurricane Beryl (July 18-21) affected Long Island and brought small
amount of precipitation. For 2007, hurricane Barry (June 1-2) passed over Long Island
but did not contribute much precipitation because of its short duration.
While orographic lifting is well known on oceanic islands and mountains,
precipitation also can become enhanced via a “seeder-feeder” mechanism over relatively
small hills (50-200m) (Storebo 1976).

Colle and Yuter (2006) indicated that the

differential surface roughness at the coast and the hills of Long Island (30-80m) enhanced
the surface precipitation by 30%-50% over these regions compared with Long Island
Sound. The impact of topography on the spatial distribution of precipitation can be seen
from 2004 and 1960 annual precipitation maps. With relatively more precipitation
accumulated on the high elevation area in the northeast as to areas of low elevation along
South Shore and central Long Island.
4.1.2 Cold Season (November through March)
During the cold season, much of precipitation on Long Island is related to
Nor’easters. New England generally experiences at least one or two Nor’easters each
year with varying degrees of severity (Wikipedia 2008). Nor’easters can cause either rain
or snow on Long Island depending on the temperature. Air above the freezing point in the
lower level atmosphere usually brings cold rain, whereas air below freezing point brings
snow and blizzards. If the layer of air below freezing is thin above a cold land surface,
freezing rain will form instead of snow. Notable Nor’easters for 2004 and 2007 are
“white Juan” and “Valentine’s Day Blizzard” (Wiki 2008). White Juan hit northeastern
US on Feb 2004, contributing a large amount of precipitation to Long Island. The 2007
Valentine’s Day Blizzard brought a non-romantic Valentine’s Day to Long Islander with
large amount of snow and ice. It contributed 2-3 inches equivalent of wet precipitation to
Long Island.
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Another source of winter precipitation can be attributed to air lifting along frontal
boundary. Cold air sweeps southeastward along the St. Lawrence River Valley replacing a
warm air mass at the surface (Miller and Frederick, 1969). The warm air rises and
precipitation forms at the frontal boundary in the form of light showers or snow flurries.
Another type of low that moves northeastward along the western side of the
Appalachian Mountains comes close enough to Long island to cause precipitation (Miller
and Frederick, 1969). Frontal lifting and horizontal convergence about the low are the
cause of this kind of precipitation. It has a smaller influence on Long Island cold season
precipitation compared with Nor’easters and frontal boundary lifting.
Hurricanes may also bring some precipitation during cold season. For example,
hurricane Noel 2007 (October 28-November 2) passed Long Island to the east and
contributed some precipitation in the form of rain.

4.2 Importance of precipitation pattern in understanding Long Island
Groundwater
4.2.1 Seasonal precipitation pattern and Evapotranspiration
Precipitation is the only source of naturally occurring fresh water on Long Island,
and its study is the logical first step in developing a quantitative understanding of the
hydrologic cycle (Miller and Frederick, 1969). The long term areal distribution of
precipitation is thus critical to understand the recharge of Long Island’s groundwater.
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Figure 4. 1 Hydrologic Cross Section of Long Island
(Modified from McClymonds and Franke, 1972 by Busciolano 2002)

Figure 4.1 shows the hydrologic units in the Long Island aquifers. The main source
of groundwater comes from the sands and gravels of the Cretaceous Magothy Aquifer
(Busciolano 2002). The Magothy Aquifer is overlain on much of the island by the Upper
Glacial Aquifer which is composed of sands and gravels deposited during the Pleistocene.
The deeper Lloyd Aquifer is reserved for limited use because the overlying Raritan
Confining Unit greatly restricts recharge. Runoff to streams is limited due to the
immature stream development on Long Island. Much of the runoff from impervious
surfaces is directed to recharge basins.
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During the warm season, all precipitation types (convective storm, air mass
thunderstorm and hurricanes) are typically characterized by relatively short period (hours)
of intense precipitation (Busciolano 2004). Much of the rainfall that enters the
unsaturated zone taken up by plants and soils is lost to the atmosphere via
evapotranspiration. Therefore, little or no recharge reaches the water table during summer
(Busciolano 2004).
During winter months, precipitation often occurs for longer periods (several days)
and occasionally results in snowmelt. Because of the dormant vegetation, much of the
precipitation infiltrates to the water tables as recharge. Thus, most aquifer recharge occurs
during the cold season (Steenhuis 1985).
It has been estimated that about 50% of the annual precipitation on Long Island
infiltrates down through the unsaturated zone to recharge the aquifer (Peterson 1986,
Robbins 1996). It is estimated that approximately 85% of the precipitation falling during
the island’s seven month non-growing season (October through April) recharges the
aquifer, while nearly all precipitation falling during the five month growing season (May
through September) is lost to evapotranspiration (Steenhuis et al. 1985, Robbins 1996).
The amount of infiltration that finally reaches water table greatly depends on the actual
evapotranspiration rate during different seasons. The long term evapotranspiration for
Nassau and Suffolk Country on Long Island was studied by Peterson in 1986 (Figure 4.2)
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Figure 4. 2 Long Term Evapotranspiration in Nassau and Suffolk County
(Peterson 1986)
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4.2.2 Influence of precipitation pattern on groundwater recharge

Figure 4. 3 Generalized flow lines in the ground-water system of Long Island, N.Y., under
predevelopment conditions. (Modified from Franke and Cohen, 1972 by Busciolano 2002)

The water table on Long Island is mainly within the upper glacial aquifer and is
recharged by precipitation that infiltrates downward through the unsaturated zone
(Busciolano 2002) (Figure 4.2). Precipitation falling on the center of Long Island can
reach the Magothy aquifer (78%) and Lloyd aquifer (4%) and become groundwater
resources that we rely on (Busciolan 2002).

Precipitation falling on the north and south

shore areas, as well as the east and west of Long Island provide more limited recharge to
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the Magothy Aquifer. The long term recharge for Nassau and Suffolk Country on Long
Island was studied by Peterson in 1986. The result map was overlaid onto DEM and
shown as follows (Figure 4.3)

Figure 4. 4 Mean Long Term annual recharge in Nassau and Suffolk County (Peterson 1986)

For 2004 cold season, February, March and November monthly precipitation maps
show that majority precipitation accumulated in the center part of Long Island. Because
the evapotranspiration rate is very low during the cold season, most of the 2004 February,
March and November precipitation could reach water table and recharge the groundwater.
For 2004 warm season, none of the six monthly precipitation maps show larger central
part accumulation pattern. Therefore, the amount of water that could reach groundwater
water table is even smaller because of the high evapotranspiration rate during warm
season.
For 2007 cold season, January and November precipitation maps indicate that
majority of monthly precipitation accumulate in the center of Long Island, which means
more groundwater recharge during these two months. For 2007 warm season, June and
July monthly precipitation maps show more accumulated rainfall in the center of Long
Island, and the average rainfall amount is also high for these two months (5 inch/month
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and 6 inch/month respectively, compared to 1.5 inch/month for 2007 May). Although the
evapotranspiration rate could also be high during these two months, the groundwater
recharge rate could be higher than other warm season months in 2007.

4.3 Application of radar rainfall data
The results of this study show that precipitation on Long Island has high spatial and
temporal variation. It is not possible financially to create a network of rain gauges
capable of measuring precipitation to the resolution and extent necessary for hydrologic
or meteorology applications (Wang et al. 2008). The radar system in effect since 1996 is a
way to provide useful information regarding precipitation with much higher spatial and
temporal resolution. For Long Island, comparison of precipitation measurements using
rain gauges and radar from 2004 to 2007 shows good agreement, which make us more
confident to use the radar precipitation data.

As a result, the long-term precipitation

results from the radar data can by used as inputs for rainfall related applications.
Precipitation is the most important input for many hydrological models. A series of
publication discussed the incorporation of radar precipitation data into their regional
hydrologic models and evaluate their application (Moreda et al. 2002, Xie et al. 2006,
Chen and Farrar 2007). Long Island, which depends solely on groundwater for its water
supply, has two earlier groundwater models developed by Camp, Dresser and Mckee for
Nassau County and Suffolk County in 1990 and 1996 respectively. Precipitation variation
data are an important input for the model to evaluate the groundwater level fluctuation.
Both of these two models used annual rain gauge data as input, which may have potential
inaccuracy problems (e.g. Legates and DeLiberty 1993). Therefore, long-term (5-10 years)
average annual precipitation data are needed as more accurate inputs. NEXRAD
precipitation data are more continuous and have a higher spatial resolution than rain
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gauges. Therefore, we think that radar data should be used as the rainfall input for Long
Island hydrologic models.
NEXRAD precipitation results are also useful for other rainfall related applications,
like rainfall run-off modeling, climate modeling and drought monitoring (Finnerty et al.
1997, Rivington et al. 2008 and Voinov et al. 2007).

4.4 Suggestions to potential user
NEXRAD precipitation data is a good substitute for rain gauge data for rainfall
related applications. The high spatial and temporal resolution of radar precipitation data
make it more valuable for hydrology studies. The low cost of the radar data make it a
more preferable way to get the rainfall data for larger areas. Besides, NEXRAD provides
continuous precipitation data over 10 years. Whereas rain gauges always have bias,
missing data or overflow (e.g. Legates and Deliberty 1993).
Potential users who want to incorporate long-term NEXRAD data into their
research should pay attention to following things. First, beam blockage. Radar beam
blockage is a common problem for each radar station in Northeast River Forecast Center.
There are numbers of reasons for radar beam blockage. A high stack, a tall building, or a
tall wind farm near the radar station can block the radar causing an apparent low rainfall
along the radar path. Radar beam blockage, however, applies only to small areas within
the blockage zone. More than 95% (by area) of data are good within the coverage of
single station.
Second, bad data points. The degraded data quality may result from truncation error
to untimely calibration of the radar data. Also NEXRAD overestimation is caused by the
presence of hail, large raindrops, or melting. Underestimation is caused by small
raindrops, attenuation, truncation error, and beam blockage (Schmi and Wuest, 2005). In
order to identify the potential problems within your study area the user should process the
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data month by month, and use the monthly results to get the seasonal and annual
precipitation results. This could help you explore the monthly pattern map for more
details about the long term rainfall variability, and identify the potential error source to a
single month.
Third, while the data processing is complicated, the resulting GIS-based NEXRAD
precipitation database is convenient. All the scripts are in the appendix and can be
directly used to automatically process the NEXRAD stage III and MPE precipitation
data.
Therefore, potential users of NEXRAD precipitation data should think about
cutting out bad data points or the area affected by the blockage before they apply it to
regional hydrologic modeling. I also suggest potential users to develop an error or
uncertainty estimate for the cumulative values if the precipitation data is to be used for
calculating recharge on a small scale.
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Appendix 1: Perl Script to untar files
#!/usr/bin/perl -w
# first, look for files of the form xmrg_[MM][YYYY]_NE.tar
# if found, untar file, then
#

for each file of the form

#

xmrg_[MM][DD][YYYY], where MM and YYYY are as previously found,

#

untar the file.

Then for each file of the form

#

uncompress the file

#

convert it to ascii

#

aggregate ascii hour files into ascii daily file

#

delete individual z files

#

delete the daily tar file

xmrg[MM][DD][YYYY][HH]z.Z

$BASEDIR = ".";
#$OUTPUTDIR="output";
#$tar = "/bin/gtar";
$xmrg2asc = "../mpe2ascLinux";
#$aggregate = "../aggregate";
print "note: running type E (after Jan 2005) Linux MPE version script\n";
`sleep 2`;
opendir(DIRHANDLE, $BASEDIR) || die "can't open $BASEDIR\n";
@filelist = readdir(DIRHANDLE);
closedir(DIRHANDLE);
foreach $file (@filelist) {
if ($file =~ /^xmrg_([0-9]{2})([0-9]{4})_NE.tar$/) {
$monthfile = $&;
$month = $1;
$year = $2;
printf "*** unpacking $monthfile ($month-$year)\n";
system "tar xvf $monthfile";
opendir(DIRHANDLE, $BASEDIR) || die "can't open $BASEDIR\n";
@filelist2 = readdir(DIRHANDLE);
closedir(DIRHANDLE);
foreach $file2 (@filelist2) {
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if ($file2 =~ /^xmrg_${month}([0-9]{2})${year}_NE\.tar\.gz$/x) {
$day = $1;
$dayfile = $&;
print "*** unpacking $dayfile ($year-$month-$day)\n";
system "zcat $dayfile | tar -xv";
system "rm $dayfile";
opendir(DIRHANDLE, $BASEDIR) || die "can't open $BASEDIR\n";
@filelist3 = readdir(DIRHANDLE);
closedir(DIRHANDLE);
foreach $file3 (@filelist3) {
if ($file3 =~ /^xmrg_${month}${day}${year}_([0-9]{2})z_NE$/x) {
$hourfile =$&;
print "*** converting MPE $hourfile ...\n";
system "$xmrg2asc $hourfile";
system "rm $hourfile";
}
}
#print "*** aggregating hours into one file\n";
#system "$aggregate xmrg_${month}${day}${year}
xmrg_${month}${day}${year}_??z_NE.asc";
}
}
}
}

52

Appendix 2: C script to convert Binary to ASCII
/* vsf mpe2ascLinux.c
will extract RFC MPE xmrg formatted HRAP precipitation data pretending the header data to
directly load as an ArcGIS ESRI grid using ascii2grid tool. However, ESRI Grids are built upper left
to lower right while the HRAP is encoded lower left to upper right. To correctly load the HRAP
precipitation data as an ESRI grid the xmrg HRAP matrix must be inverted, ie. the last row is
inserted first.
Projection for the resulting ESRI grid can then be defined:
North Pole Stereographic
Latitude of origin 90.00
Longitude -105.00
Reference Latitude 60.00
Earth radius 6371200.000 m
grid cell size 4762.5 m

derived from - read_xmrg_lin.c
drived from

- Linux_xmrg2hrap_dataload.c

A modified version of read_xmrg.c to workwith Little Endian machines.
This program reads a Linux MPE xmrg file and writes to an ASCII vector file with each line
containing col# row# and data (in mm) starting from lower left corner of the region.
1) To create an executable; (on Linux) using gcc: gcc *.c -o read_xmrg_lin
2) To run; mpe2ascLinux xmrg_mmddyyyy_hhz_WG where xmrg_mmddyyyy_hhz_WG is an
input XMRG file
name.

The output file produced is xmrg_mmddyyyy_hhz_WG.asc.

The orientation of the precipitation field with respect to the
i and j indices used in the program is as follows:
i

j

physical location

-----------------------------------------------------------------0
MAXX-1

0

lowerleft corner of the RFC rectangle
0

0 MAXY-1

lowerright corner of the RFC rectangle
upperleft corner of the RFC rectangle
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MAXX-1 MAXY-1

uppperright corner of the RFC rectangle

The HRAP coordinates of the lowerleft corner of the RFC rectangle is given by (IORIG,JORIG)
in the XMRG file header (see below).

Note that the point (float(IORIG),float(JORIG))

corresponds to the lowerleft corner of the HRAP box in the lowerleft corner of the RFC rectangle.
The lat-lon of this point can be obtained from the subroutine hrap_to_latlon(float(IORIG),
float(JORIG), flon,flat). Likewise, the lat-lon of the upperright corner of the HRAP box in the
upperright corner of the RFC rectangle is given by
hrap_to_latlon(float(IORIG+MAXX),float(JORIG+MAXY),flon,flat). */
#include <stdio.h>
#include <math.h>
#include <stdlib.h>
#define NULLVALUE -999.000
main(int argc,char *argv[])
{
FILE

*in_file_ptr,*out_file_ptr;

char

out_name[20];

int

rfchd[4];

int

*numbytes;

int

MAXX,MAXY,IORIG,JORIG;

int

i,j;

float xstereo,ystereo;
int nrows,ncols;
short *onerow;
float **matrix;
float outval;
/* end variable declaration */
if (argc != 2)
{
(void)printf("Incorrect number of arguments. Should be 2.\n");
exit(0);
}
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in_file_ptr=fopen(argv[1],"rb");
if (in_file_ptr == NULL)
{
(void)printf("Can not open file %s for input.\n",argv[1]);
return(1);
}
(void)strcpy(out_name,argv[1]);
(void)strcat(out_name,".asc");
out_file_ptr=fopen(out_name,"w");
/* start reading the XMRG file*/
/*SEEK_SET specifies the position offset from the beginning of the file*/
/* start off by seeking over the size field for the first record to 4th byte */
fseek(in_file_ptr, 4, SEEK_SET);
/*read each of the 4 hrap header values */
for(i=0;i<4;i++)
{
fread(&rfchd[i], sizeof(int), 1, in_file_ptr);
}
/* reverse byte order was for handling big-endian on little-endian machines */
/* MPE production now on Linux little-endian so no longer issue */
/* (void) reverse_byte_order(rfchd,4); */
IORIG=rfchd[0];
JORIG=rfchd[1];
/*vsf--adding next 2 lns, changing to polar stereographic coordinates vice HRAP*/
/*for ESRI grid manipulation */
xstereo=IORIG*4762.5-401.0*4762.5;
ystereo=JORIG*4762.5-1601.0*4762.5;
MAXX=rfchd[2];
MAXY=rfchd[3];
/*vsf--adding header entries needed for ESRI ascii2grid import to ArcGIS*/
nrows = MAXY;
ncols = MAXX;
/*vsf--print to ascii2grid ready header file*/
(void)fprintf(out_file_ptr,"ncols %d\n",MAXX);
(void)fprintf(out_file_ptr,"nrows %d\n",MAXY);
(void)fprintf(out_file_ptr,"xllcorner %f\n",xstereo);
(void)fprintf(out_file_ptr,"yllcorner %f\n",ystereo);
55

(void)fprintf(out_file_ptr,"cellsize 4762.5\n");
(void)fprintf(out_file_ptr,"nodata_value %.3f\n",NULLVALUE);
/*echo to screen*/
/*vsf--change for ESRI ascii2grid support*/
(void)printf("xllcorner %f\n",xstereo);
(void)printf("yllcorner %f\n",ystereo);
(void)printf("cellsize 4762.5\n");
(void)printf("processing MPE data ...\n");

/*each record is preceded and followed by 4 bytes showing record size*/
/*so first xmrg record is always 4+16+4 bytes*/
/*Ready to read second FORTRAN record*/
fseek(in_file_ptr, 24, SEEK_SET);
/*first read the size of second record */
fread(&numbytes,sizeof(int),1,in_file_ptr);
(void)printf("numbytes %d\n",numbytes);
/***********************************************************
*

account for all possible header lengths in xmrg files

************************************************************/
/* vsf-

we will just ignore the field values of second record and advance to start of precip data*/
if ((int) numbytes == 66)
/* first record (4+16+4)(24) plus second record(74=66+8) is 98*/
{
fseek(in_file_ptr, 98, SEEK_SET);
}

/* vsf - We will skip the older formats since these won't be processable on little-endian systems */
/* without byte reversal */
/*
else if ((int) numbytes==38)
{
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fseek(in_file_ptr, 70, SEEK_SET);
}
else if ((int) numbytes==37)
{
fseek(in_file_ptr, 69, SEEK_SET);
(void)printf("WARNING: SECOND RECORD ONLY HAS 37 BYTES\n");
(void)printf("SHOULD HAVE 38 BYTES\n");
(void)printf("Assuming data is still valid. . . \n");
}
else if ((int) numbytes == (MAXX*2))
{
(void)printf("Reading pre-1997 format.\n");
fseek(in_file_ptr,24, SEEK_SET);
}
*/
else
{
/*(void)printf("numbytes %d\n",numbytes);*/
(void)printf("Error! This file is not formated as an RFC MPE xmrg product. Data NOT
READ!\n");
exit(1);
}
/* allocate memory for arrays */
onerow = (short int*) malloc(sizeof(short int*)*MAXX);
matrix = (float**) malloc(sizeof(float*)*MAXY);
for (j=0;j<MAXY;j++)
matrix[j]=(float*) malloc(sizeof(float)*MAXX);
/* vsf - this next loop needed to be reveresed to load last row first, ie MAXY-1*/
/* otherwise when loaded into ArcGrid reads ul --> lr, HRAP recorded ll --> ur */
/* if not grid can instead be flipped*/
/* vsf - original for(j=0;j<MAXY;j++) */
/* vsf - this will now load the array reverseing the row order */
/* advancing 4 bytes at a time through file */
for(j=MAXY-1;j>-1;j--)
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{
fseek(in_file_ptr, 4, SEEK_CUR);
/* read one row */
fread(onerow,sizeof(short),MAXX,in_file_ptr);
fseek(in_file_ptr, 4, SEEK_CUR);
for(i=0;i<MAXX;i++)
{
outval = (float) onerow[i];
matrix[j][i] = outval;
} /* close i */
} /* close j

*/

/* now write out the array */
for(j=0; j<MAXY; j++)
{
for(i=0; i<MAXX; i++)
{
outval=matrix[j][i];
if (matrix[j][i] < 0)
{
(float) outval = NULLVALUE;
}
else
{
outval = outval/100.0;
/*

convert from hundredths of mm to mm */

}
fprintf(out_file_ptr,"%.3f\n",outval);
/*vsf-changed above to value only to generate ascii2grid input*/
/*change to include index to use to load a geodatabase
/* fprintf(out_file_ptr,"%d %d %f\n",i,j,outval);*/
}
}
/*free allocated memory*/
free(onerow);
for (j=0;j<MAXY;j++)
{
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free(matrix[j]);
}
free(matrix);
fclose(in_file_ptr);
fclose(out_file_ptr);
return(0);
}

/**

END OF MAIN

**/
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Appendix 3: AML scripts to convert ASCII files to GIS Grid format
/* Authors: Hongjie Xie, Xiaobing Zhou, Enrique Vivoni, Jan Hendrickx, Eric Small
/* Title of the paper: GIS-based NEXRAD Stage III precipitation database: automated approaches
for data processing and visualization
/* PURPOSE: batch process to transfer ASCII files to ArcInfo grid files, define the polar
stereographic projection for the grid files, reproject it to geographic (sphere) coordinate, and then
to UTM 13, WGS 84 (ellipsoidal earth datum) coordinate;
/* &run asc2grd1.aml
&workspace G:\RadarData\ASCData\2004ASC\012004ASCII /* for the space where store
ascRadar data and codes
&type [show &workspace]
&s count = [filelist *.asc asc.list -file]
&if %count% <= 0 &then &return Error generating output file.
&s unit := [open asc.list ok -read]
Precision Single Highest
&do I := 1 &to %count%
&s temp := [read %unit% ok]

/*temp get the name like xmrg01019600z.asc

&s tempn = [before %temp% z]

/*tempn get the name like xmrg01019600z

&s tempt = r[after %tempn% _]z
/*&s tempn = r[e %tempn% z]

/*tempn get the name like 01019600z
/*tempn get the name like r01019600

/*&s suffix = t
/*&s tempt = %tempn%%suffix%

/*tempn get r01019600u

&s tempg = g[after %tempn% _]
&s tempp = p[after %tempn% _]
/* Begin: ASCII to Grid
ASCIIGRID %temp% %tempp% FLOAT
/* Begin: Define Projection (copy from existing one)
PROJECTCOPY GRID c:\WorkSpace\z0101200018 GRID %tempp%
/* Begin: Reproject to geo
Project GRID %tempp% %tempg% # NEAREST
output
projection geographic
spheroid sphere
units dd
parameters
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end
/* Begin: Reproject to Texas Centric Mapping System, Albers Conic Equal Area,
/* Datum: NAD83, Ellipsoid: GRS80
Project GRID %tempg% %tempt% # NEAREST 4000
OUTPUT
Projection

Mercator

Units

METERS

Spheroid

GRS80

parameters
-75.000000 /* Central_Meridian
18 00 00

/* Latitude of Origin

500000.000000 /* false easting
0.000000 /* false northing
end
COPY %tempt%

G:\RadarData\GridData\2004Grid\012004Grid\%tempt%
kill %tempt% all
kill %tempg% all
kill %tempp% all
/*&s [delete %temp%]
&end
&s ok := [close %unit%]
&s ok := [delete arc.list -file]
&return
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/*reproject tempn to tempt

Appendix 4: AML scripts to sum Grids files.
/* Authors: Hongjie Xie, Xiaobing Zhou, Enrique Vivoni, Jan Hendrickx, Eric Small
/* Title of the paper: GIS-based NEXRAD Stage III precipitation database: automated approaches
for data processing and visualization
/* PURPOSE: batch process to sum hourly, daily, or monthly grids/subgrids
/* &run gridsum.aml
&workspace G:\RadarData\2004 Monthly\012004
&type [show &workspace]
&s count = [filelist * grid.list -grid]
&type %count%
&if %count% <= 0 &then &return Error generating output file.
&s unit := [open grid.list ok -read]
Precision Single Highest
grid
temp1 = [read %unit% ok]
/* GRIDCLIP temp1 tempa cover c:\workspace\rio_basinutm
&do I := 2 &to %count%
&s temp2 := [read %unit% ok]

/*temp get the name like r01019500u

&s tempz = z[before %temp2% u]
/*sum grids
sgrid = sum (temp1,%temp2%)
kill temp1 all
temp1 = sgrid
kill sgrid all
/*sum subgrids
&end
quit
rename temp1 sumgrid
/* rename tempa sumsgrid
&s ok := [close %unit%]
&return
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Appendix 5: AML scripts to clip and only sum the region of interest.
/* Authors: Hongjie Xie, Xiaobing Zhou, Enrique Vivoni, Jan Hendrickx, Eric Small
/* Title of the paper: GIS-based NEXRAD Stage III precipitation database: automated approaches
for data processing and visualization
/* PURPOSE: batch process to sum hourly, daily, or monthly grids/subgrids
/* &run gridsum.aml
&workspace G:\RadarData\2004 Monthly\012004
&type [show &workspace]
&s count = [filelist * grid.list -grid]
&type %count%
&if %count% <= 0 &then &return Error generating output file.
&s unit := [open grid.list ok -read]
Precision Single Highest
grid
temp1 = [read %unit% ok]
GRIDCLIP temp1 tempa cover c:\workspace\box_cov
&do I := 2 &to %count%
&s temp2 := [read %unit% ok]

/*temp get the name like r01019500u

&s tempz = z[before %temp2% u]
/*sum grids
sgrid = sum (temp1,%temp2%)
kill temp1 all
temp1 = sgrid
kill sgrid all
/*sum subgrids
GRIDCLIP %temp2% %tempz% cover c:\workspace\Waterbasin_cov /*BOX
306333.855790 3784270.867612 362333.855790 3812270.867612
ssgrid = sum(tempa,%tempz%)
kill tempa all
tempa = ssgrid
kill %tempz% all
kill ssgrid all
&end
quit

63

rename temp1 sumgrid
rename tempa sumsgrid
&s ok := [close %unit%]
&return
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